
© ShoreTel, Inc., 2005  11/29/2005 

RELEASE NOTES 
 

ShoreTel 6 
ShoreWare™ Call Manager Software 

 

Version 1.0 

 



ShoreTel 6 – ShoreWare Client Release Notes Page 2 of 20 

© ShoreTel, Inc., 2005  11/29/2005 

Document and Software Copyrights 
Copyright © 1998–2005 by ShoreTel, Inc., Sunnyvale, California, U.S.A. All rights reserved. Printed in the 
United States of America. Contents of this publication may not be reproduced or transmitted in any form 
or by any means, electronic or mechanical, for any purpose, without prior written authorization of Shore-
Tel, Inc. 
 
ShoreTel, Inc. reserves the right to make changes without notice to the specifications and materials con-
tained herein and shall not be responsible for any damage (including consequential) caused by reliance 
on the materials presented, including, but not limited to, typographical, arithmetic, or listing errors. 
 
Trademarks 
ShoreCare, ShoreWare, and ShoreGear are registered trademarks of ShoreTel, Inc. in the United States 
and/or other countries. 
 
ShoreTel, ShoreTel 6, ShorePhone, AnyPhone, Office Anywhere and ShoreTel Smart, are trademarks of 
ShoreTel, Inc. in the United States and/or other countries. ShoreLink is not a trademark or registered 
trademark. 
 
Microsoft, Windows, Windows NT, and ActiveX are either registered trademarks or trademarks of Micro-
soft Corporation in the United States and/or other countries. VxWorks is a trademark of Wind River Sys-
tems. All other copyrights and trademarks herein are the property of their respective owners. 
 
Version Information 
ShoreTel 6 Client Release Notes 
Build: 11.x.xxxx.x 
Part Number: 800-1040-01 
Draft 3 
Date: November 29, 2005 
 
Company Information 
ShoreTel, Inc. 
960 Stewart Drive 
Sunnyvale, California 94085 
(408) 331-3300 
(408) 331-3333 fax 
www.shoretel.com 



ShoreTel 6 – ShoreWare Client Release Notes Page 3 of 20 

© ShoreTel, Inc., 2005  11/29/2005 

 

MOBILITY FEATURES............................................................................................................................................5 
OFFICE ANYWHERE ....................................................................................................................................................5 

Overview................................................................................................................................................................5 
Configuration ........................................................................................................................................................5 

SYSTEM MANAGEMENT AND SECURITY FEATURES ..................................................................................9 
CALLER ID DISPLAY CONTROL FOR EXTENSION MONITORING ..................................................................................9 

Overview................................................................................................................................................................9 
Configuration ........................................................................................................................................................9 

SILENT CLIENT INSTALL...........................................................................................................................................10 
Overview..............................................................................................................................................................10 
Configuration ......................................................................................................................................................10 

TELEPHONES AND USER FEATURES...............................................................................................................11 
AUTOMATIC OFF-HOOK PREFERENCE ......................................................................................................................11 

Overview..............................................................................................................................................................11 
Configuration ......................................................................................................................................................12 

INSTADIAL AND HOT KEY PAD ................................................................................................................................13 
Overview..............................................................................................................................................................13 
Configuration ......................................................................................................................................................13 

SHORETEL 24 IP BUTTON BOX (BB24)....................................................................................................................14 
Overview..............................................................................................................................................................14 

SHORETEL IP PHONE (IP 110) ..................................................................................................................................15 
Overview..............................................................................................................................................................15 

PROGRAMMABLE BUTTONS......................................................................................................................................16 
Overview..............................................................................................................................................................16 
Configuration ......................................................................................................................................................17 

ENHANCEMENTS...................................................................................................................................................19 
ENHANCED DIAL TONE BEHAVIOR...........................................................................................................................19 

Overview..............................................................................................................................................................19 
LIFO VOICE MAIL HEARD QUEUE ...........................................................................................................................19 

Overview..............................................................................................................................................................19 
SYSTEM REQUIREMENTS...................................................................................................................................20 
 
 



ShoreTel 6 – ShoreWare Client Release Notes Page 4 of 20 

© ShoreTel, Inc., 2005  11/29/2005 

Introduction 

This document defines the new features as well as installation and upgrade requirements for ShoreTel 6 
ShoreWare Call Manager Software. 
 
NOTE: Call Manager only displays features that have been selected for the user by the system adminis-
trator. Enabling and disabling of system features is performed by the system administrator in ShoreWare 
Director, and cannot be changed by the end user. 
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Mobility Features 
Office Anywhere 
Overview 
 
The Office Anywhere feature lets you maintain an on-system extension presence at an external PSTN 
number (i.e. your cell phone or home analog phone) by creating a mapping between your office phone 
extension and your cell phone or PSTN phone number, making it appear as though your PSTN phone is 
part of the ShoreTel system. The feature also lets you manage phone calls via PCM, so while the conver-
sation occurs over the cell phone or home phone, the call appears via PCM and can be acted upon using 
many of the features available via PCM. (Note that you must be located near a PC that has access to a 
broadband connection and that is running PCM for this to work.) 
 
The benefits of Office Anywhere include the ability to: 

• Use the existing PSTN line for voice while managing the call via PCM over an ordinary 
broadband Internet connection 

• Emulate analog extension hook switch actions via star-star (**) for FLASH and pound-pound 
(##) for on-hook/off-hook 

• Keep your directory number at the office 
• Make it appear that you are calling from the office 
• Minimize communication costs with flexible IP & trunking requirements 
• Retain call management features of the ShoreTel system while maintaining audio quality 

(without requiring a good IP connection) 
 
Office Anywhere is intended for mobile workers or people who work from home. The feature supports 
workgroup and contact center agents who are working remotely via a PSTN phone in a manner that is 
transparent to the workgroup/contact center routing application. 
 
Details: 

• Incoming calls to your extension will ring on your cell phone or off-system extension. If you do not 
answer the call, normal call handling lets the caller leave a message in your ShoreTel mailbox.  

• Office Anywhere is fully controllable using PCM, except for answering a call, which must be done 
manually. The feature will also have limited TUI functionality. 

• Calls placed or answered using Office Anywhere will continue to show in the PCM call stack.   
Normal call control functions such as hold, unhold, conference, transfer, and park will continue to 
work. Park onto the Office Anywhere extension will not be supported. 

• Office Anywhere will function somewhat like an automated “Find Me” feature, except the caller 
will not have to “press 1 to find me” because the PSTN phone number will be called immediately. 
There are two ways to cause the call to be answered under both these behaviors: either by click-
ing “Answer” on the PCM, or by pressing the DTMF digit 1 in response to the repeated prompt. 
Note that you must answer the call on your PSTN phone manually before doing either of these 
operations. 

 
 

Configuration 
The system administrator must modify the Class of Service Telephony attributes of the user group to 
which you belong before you can enable the Office Anywhere feature. Once this has been done, you can 
configure the Office Anywhere feature on your client machine by following the procedure below: 
1. Launch Personal Call Manager (PCM) on your client machine. 
2. Click on the File menu and select External Assignment, as shown below. 
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Figure 1 – Using PCM to configure the client machine for Office Anywhere 

 
3. When you select External Assignment, a pop-up window similar to the one shown below appears. 
 

 
Figure 2 – Select the Enable External Assignment check box 

4. Select the Enable External Assignment check box.  
5. Click on the Phone Number drop-down menu and select the external phone number where your 

calls will be routed. (This can be your cell phone number, your home number or any other PSTN 
number that is not within the ShoreTel system.) If the external number has not already been entered, 
you can do so now. 
Note: You cannot configure a PSTN number that would require the call to go out a SIP trunk. 

6. Select the desired Activation Settings radio button. Office Anywhere initiates a dialog at the external 
number prompting the user to press their keypad "1" to accept the call. 

• Wait for Answer – The calling party will be connected to the Office Anywhere user as soon as 
he answers his cell or home phone. 

• Wait for DTMF – The calling party will be connected to the Office Anywhere user after the Of-
fice Anywhere users hits the appropriate DTMF key. 

7. Click the OK button to store your changes.  
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8. From PCM, click the Options menu and select Configure Call Handling. 
9. In the Call Forwarding Condition area of the window, select the When No Answer or Busy radio but-

ton (if it has not already been selected). 
10. Under the Call Forwarding Destination area of the window, click the Edit Destination button to dis-

play a window similar to the one shown below: 
 

 
Figure 3 - No Answer Number of Rings 

 
11. In the Forward after x rings, select 4 or more rings. (The default, 3 rings, makes it difficult to answer 

calls before they go to voice mail.)1 
12. Click OK. 
 
 
 
 
 

                                                      
1 This parameter can also be set system-wide via the Call Handling Mode Defaults link in Director. 
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When finished, you can verify that Office Anywhere is enabled on your client machine by looking for the 
cell phone icon at the bottom right corner of the PCM window (as shown in Error! Reference source not 
found.). By hovering over the cell phone icon, a pop-up window should display the phone number that 
you entered above, indicating that this phone number has been mapped to your office extension. 
 
 

 
Figure 4 - Verifying proper PCM configuration 
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System Management and Security 
Features 
Caller ID Display Control for Extension Monitoring 
Overview 
The Caller ID Display Control feature is an enhancement to the extension monitoring function. (Extension 
monitoring is one of the functions you can assign to the custom buttons on your IP 530/560 phone or 
BB24 device.) Due to the complexity of this feature, we will discuss it separately from the other functions. 
 
Extension monitoring lets you monitor the extension of another user and answer that person’s calls if nec-
essary. For example, consider a hypothetical scenario in which there are two administrative assistants 
working on different floors of the same building. They are both responsible for answering calls from the 
main phone line, but they cannot see one another. If one is already on a call when another call arrives, 
the second assistant will see that the first assistant is busy and will know to pick up the incoming call. 
 
However, this ability to peer into the phone activities of other users on the system can present some is-
sues with privacy (e.g. an administrative assistant may be able to see that an executive is receiving calls 
from an important “hush-hush” sales account). To address such privacy concerns the extension monitor-
ing function has been enhanced to offer control over who can see the caller ID information, (i.e. you can 
configure the system to prevent the monitoring party from seeing the caller ID information about the per-
son who is calling the monitored party’s extension). The monitoring party will only see that the monitored 
extension is on a call. 
 
Details: 

• The custom button will illuminate red (on the monitoring-person’s phone) when the person 
being monitored is on a call. If that call is put on hold and a second call is accepted on the 
monitored extension, the LED will turn green and will flash twice. Similarly, the LED will flash 
three times if a third call is accepted. 

• This feature can be configured so that the phone of the monitoring party will not ring until the 
monitored party’s phone has rung a specified number of times. This “delayed ring” behavior 
prevents the monitoring party’s phone from ringing while giving the monitored party a chance 
to answer the call. If the monitored party has not answered the call within the specified num-
ber of rings, the monitoring party’s phone will begin to ring. 

• The custom button (to which extension monitoring has been assigned) can serve dual pur-
poses based on whether the monitoring party is in a call or not. The button can be set to 
speed dial, intercom, or transfer calls to the monitored extension. 

• When the "Show Caller ID Name and Number on Monitored Extensions" Class of Service Te-
lephony setting is not enabled, PCM Extension Monitor (and Agent Monitor) show the num-
ber of calls on a user's stack but does not show who they are talking to, and "Properties" is 
also disabled.  

 
 
 
 

Configuration 
Contact your system administrator to enable or disable Caller ID Display controls on your IP 530/560 
phone or BB24. These configurations can only be performed via ShoreWare Director.  
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Silent Client Install 
Overview 
With this release of the ShoreTel 6 product, the process of upgrading the client software on remote ma-
chines has been improved such that administrative rights are no longer needed by the person running the 
install/upgrade or the client machines. Now your system administrator can easily upgrade the software on 
your computer regardless of the permissions associated with those machines or the users who log into 
your PC. Many of the changes are reliant on Microsoft Active Directory, and the configurations must be 
performed by your system administrator. Additional information on performing a Silent Client Install can 
be found in the ShoreTel 6 Server Release Notes.  
 

Configuration 
No configuration is required on your part. 



ShoreTel 6 – ShoreWare Client Release Notes Page 11 of 20 

© ShoreTel, Inc., 2005  11/29/2005 

Telephones and User Features 
Automatic Off-Hook Preference 
Overview 
ShoreTel 6 allows you to select which audio path (speakerphone or headset) is automatically activated 
when you place a call or when you receive a call. This added flexibility is intended for ShoreTel users who 
rely primarily on their headset for conversations.  
 
In previous releases, headset users would typically press the Headset button on the IP phone and then 
enable Handsfree Mode on PCM (to suppress the drone of dial tone). With this release, you can simply 
set the audio path to Headset via PCM, and incoming and outgoing calls will be directed through the 
headset without you ever having to touch the IP phone. You can control the call activity with PCM. 
 
Another aspect of this new feature is that it provides better notification for incoming calls. In previous re-
leases, when the Headset button on an IP phone was enabled, the phone would no longer ring to an-
nounce calls. You could see incoming calls announced on PCM or you would have to listen for the subtle 
call-waiting beep over the headset. But if you removed the headset or stepped away from your desk to 
talk to a coworker for a moment, you would not hear the call-waiting tone and could easily miss the visual 
cue on PCM. Thus, it was easy to miss incoming calls. 
 
However, with this release the new behavior provides better notification for incoming calls by generating a 
call-waiting tone when the default audio pathway is set to Headset and the headset is enabled, and by 
having the IP phone ring at normal volume if the headset is disabled. 
 
Notes: 

• The ability to select the audio path will only be supported on the IP530 and IP560 phones. 
• The featured can be configured from Director, PCM, or from the IP phone. (Directions are pro-

vided below for configuring the feature using each of these methods.) 
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Configuration 
To configure the Automatic Off-Hook Preference feature from PCM, follow the procedure below: 
1. Launch PCM. 
2. Click on the Options menu. 
3. Select Auto Off-Hook Preference, and then select Headset, as shown below: 
 

 
Figure 5 - Selecting Headset as Auto Off-Hook Preference from PCM 

 
 
To configure the Automatic Off-Hook Preference feature from an IP phone, follow the procedure below: 
1. Press the Options button on your IP530/560 phone.  
2. Enter your password at the prompt and press the OK soft key. 
3. Use the scroll key to select the second option from the list 2. Def. Audio Path2. 
4. Press the Edit soft key. 
5. Use the scroll key to select 2. Headset from the list. 
6. Press the OK soft key. 
7. Press the Done soft key to save your changes. 

                                                      
2 “Handsfree Mode” has been moved from 2nd to 6th in the Options menu; the user must scroll down to 
reach it now. 
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InstaDial and Hot Key Pad 
Overview 
In previous releases, many telephony functions required users to press a soft key after entering a string 
of digits in order to complete the operation (e.g. transferring or parking a call). ShoreTel 6 eliminates this 
rather cumbersome requirement with the use of a configurable timeout period. Instead of having to press 
a soft key to complete a call function, the desired action will occur automatically at the expiration of a con-
figurable timeout period. 
 
The InstaDial feature lets you to transfer a call by pressing the Transfer button and entering the destina-
tion number (which could be an extension or an external number). Once all of the necessary digits have 
been entered (which could vary based on the dialing plan for your site), digit collection stops and the 
timeout period begins counting down. At the end of the countdown, which can be as short as one second, 
the call is transferred.3 
 
Similarly, the Hot Key Pad feature lets you place a call while the handset is “on-hook” simply by dialing 
the required number of digits and then waiting for the configurable timeout period to expire. The system 
administrator must configure the timeout period via ShoreWare Director. There is no configuration re-
quired on your part. 
 
Note that configuring this value will affect the behavior of many different features on a system-wide basis. 
The following features will be affected by this change: 

• Conference 
• Dialing from the Directory 
• Intercom 
• On-hook dialing 
• Park 
• Pickup 
• Redial 
• Transfer 
• UnPark 

 
The timeout period can only be set once for the entire system. You cannot configure different timeout pe-
riods for different features or for different users. 
 
Details 

• The default behavior for transfers is a consultative transfer. 
• Pressing any soft key before the timeout period has expired will cancel the InstaDial behav-

ior. 
• Hanging up the phone before the timeout period has expired will expedite the action. 
• The feature affects programmed buttons that are configured without a destination as well. 
• The following functions are activated when the phone goes off hook: 

o Directory 
o Intercom 
o On-hook dialing 
o Redial 

  

Configuration 
All configurations must be performed by the system administrator through ShoreWare Director. The time-
out period cannot be configured using PCM or the IP phone interface. 
 
 

                                                      
3 Note that this automatic transfer behavior applies only to blind transfers. If a consultative transfer is 
placed, the call will remain in the call stack until the far end answers. 
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ShoreTel 24 IP Button Box (BB24) 
Overview 
The new ShoreTel 24 IP Button Box pro-
vides additional shortcut functions for users 
of the IP530 and IP560 phones. The BB24 
behaves like an additional set of 24 custom 
keys in additional to the 3 on the IP530 or 6 
on the IP560.   

 
• For detailed information on 

available options and how to 
use them, refer to the ShoreTel 
24 IP Button Box User Inter-
face Guide. 

• For installation instructions, re-
fer to the ShoreTel 24 IP But-
ton Box Quick Install Guide (in-
cluded with every BB24). 

 

    

Features:  
• Each Button Box has 24 cus-

tom keys 
• 4 Button Boxes may be as-

signed to an IP530/IP560 
phone.   

• Takes advantage of the "Pro-
grammable Buttons" feature, 
new in this release. 

• Each user may define layouts 
for up to four BB24's thus al-
lowing a user to have a maxi-
mum of 98 (if IP530) or 101 (if 
IP560) programmable buttons. 

• Each "button" is an LED-
enabled hard key and has an 
associated 6 character label on 
the LCD. 

• Ethernet switch port allows 
connection of a PC to the back 
of the button box. 
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ShoreTel IP Phone (IP 110) 
Overview 
 
The new IP phone extends the range of available 
ShoreTel IP Phone choices from basic features to 
enhanced features.  
 

• For detailed information on available 
options and how to use them, read 
the ShoreTel 110 IP Phone Tele-
phone User Interface Guide. 

• For installation instructions refer to 
the ShoreTel 110 IP Phone Quick In-
stall Guide (included with every 
phone). 

• Refer to the ShoreTel 6 Planning and 
Installation Guide for information re-
garding assigning network parame-
ters to the phones. 

Features: 
• IP110 – General User 
• Cost effective telephone targeted at 

the masses 
• 1 line appearance 
• 6 function keys (Conference, Hold, In-

tercom, Redial, Transfer, Voice Mail) 
• Ethernet Switch port allows connec-

tion of a PC to the back of the phone. 
Alternatively, the phone can be pow-
ered by connecting it to the Ethernet 
port on a ShorePhone 24 IP Button 
Box. 
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Programmable Buttons 
Overview 
ShoreTel 6 allows you to change the functions associated with the custom buttons on some IP phones 
and on the button box. You can create shortcuts for operations that would normally require pressing two 
or three buttons to accomplish the same task. 

 
For example, the action associated with the bottom button on an IP 530/560 could be configured to 
speed-dial a particular extension or external number. The button above that could be set to perform over-
head paging, and so on. All of the custom buttons are configurable except for the top-most button, which 
is permanently set to provide call appearance information (i.e. ringing indicator and call timer informa-
tion).4 
 
You can evaluate which actions you perform on a regular basis and then associate those actions with the 
custom buttons so that instead of having to dial a star code (such as *14 for picking up the Night Bell), 
you can just press one button. See the table on the following page for supported functions. 
 
Details: 

• After a function is assigned to a button, you can enter a label (up to five characters on the IP 
530/560 and up to six characters on the IP 100 and BB24). The label appears on the LED 
display next to the custom button. 

• The programmable button feature is supported on the IP 100 and IP 530/560 models but is 
not supported on the analog models or on the IP 110 or IP 210 models. 

• If your phone is an IP100, the system administrator can configure the custom buttons on your 
phone via ShoreWare Director. This particular model cannot be configured via the telephone 
interface and must be configured via Director. For all other phones that support custom but-
tons, the administrator must enable permissions for you (and for any other end users) before 
you can modify the custom buttons on your IP phone via the telephone interface. 

• The IP100 does not have custom buttons, but the soft keys can be configured (via Shore-
Ware Director) in the same way that custom buttons are configured on the other phones. 

                                                      
4 This is true for IP 530/560 phones, but the new BB24 button box does not support call appearance.  

custom buttons 
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Supported Functions: 
Function Parameter Comments 
Barge In Extension or none  
Call Appearance None Not supported on Button Box 
Conference Blind Extension or external number  
Conference Consultative Extension or external number  
Conference Intercom Extension or none  
Dial Mailbox Extension or none  
Dial Number (Speed Dial) Extension or external number  
Intercom Extension  
Monitor Extension Extension  
Page None  
Park Extension or none  
Park and Page Extension or none  
Pickup Extension or none  
Pickup Night Bell None  
Pickup/Unpark Extension or none Uses internal presence to deter-

mine which operation to perform 
Record Call None Operates on selected call in con-

nected; Pressing a second time 
stops the recording 

Record Extension Extension  
Send Digits Over Call Extension  
Silent Monitor Extension or none  
Transfer Blind Extension or external number  
Transfer Consultative Extension or external number  
Transfer Intercom Extension or none  
Transfer to Mailbox Extension or none  
Transfer Whisper Extension or none  
Unpark Extension or none  
Whisper Page Extension or none  
Whisper Page Mute None  
  

Configuration 
Note that before you can program the custom buttons on your phone, the administrator must first enable 
you to do so. Contact your system administrator to find out whether you have permissions to configure 
the programmable buttons. 
 
To change the custom buttons on your IP 530/560 phone or BB245 via the telephone interface, follow the 
procedure below: 
1. Press the Options button on your IP phone and enter your password, followed by the # key. 
2. Scroll through the list to option 4. Program Buttons. 
3. Press the Edit soft key.  
4. Press the custom button that you would like to modify. (If you are modifying the buttons on the BB24 

device via the 530/560 interface, press the button on the BB24 that you would like to configure.) 
5. Scroll through the list of functions until you find the function that you would like to apply to this button. 
6. When you have highlighted the appropriate function, press the Next soft key. 
7. Enter an extension, external number, or leave it blank. Then, press the Next soft key. 
8. Press the 1 -> Aa soft key to shift the key pad to alphabet mode. 
9. Use the key pad to enter a short descriptive word that will remind you of the new function of the cus-

tom button. 

                                                      
5 The BB24 device is attached to an IP 530/560 and must be configured through the phone’s interface. 
You cannot configure the BB24 through the device’s own interface. 
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10. Press the Done soft key. 
11. Press the Done soft key again to store your changes. 
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Enhancements 
Enhanced Dial Tone Behavior 
Overview 
The IP phone now goes on-hook when the far end hangs up. No configurations are necessary. 
 
 
 
LIFO Voice Mail Heard Queue 
Overview 
After listening to voice messages, the heard queue plays back in last in, first out order. No configurations 
are necessary. 
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System Requirements 
Required Desktop PC Configurations 
 

Operating Systems Windows XP – Professional 
• Service Pack 1 and 2 
• Themes Supported 

Windows 2000 Professional 
• Service Pack 4 or Greater  

Windows 2000 Terminal Server 
• Service Pack 4 or Greater 

Citrix MetaFrame XP Presentation Server 
• Feature Release 3 

Microsoft Outlook Integra-
tion 

Outlook 2000 
• Service Pack 2 

Outlook 2002 (XP) 
• Service Pack 2 

Outlook 2003 
• Service Pack 2 

 
Note: Outlook must already be installed and 
configured with the user’s email information 
before installing Outlook integration features. 
 
Note: Outlook 2002 and prior must be config-
ured for workgroup mode (i.e. to support mul-
tiple mail service providers) and not for Inter-
net only mode. This must be done before in-
stalling Outlook integration features. 
 
Note: The Collaboration Data Object is re-
quired for the Automated CHM changing fea-
ture, but is not required for contact import, 
contact popping, or VM integration. 

 
For ShoreTel 6 desktop applications to function correctly, you must install the Client for Microsoft Net-
working. Refer to the ShoreTel 6 Planning and Installation Guide for additional information about desktop 
requirements. 


